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ABSTRACT

Now a day the amount of polluted air in our country is very high compared to other
countries in the world. Polluted air is harmful to human and animals. So we have created
an air purifier to release a clean and healthy air. An air purifier is provided having a
purifier housing and an air way housing mounted therein. A fan having a cylindrical
whirlpool leaf construction is mounted within the air way housing and air is directed in a
predetermined direction through an air exit opening formed in a wall of the purifier
housing. In this cylindrical house air input from down and high efficiency particulate air

filter is refining the air and an exhaust fan flow the fresh air in outside.
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CHAPTER 1
INTRODUCTION

1.1 Introduction

The most common problem during the summer season is pollution, dust, and allergies.
With increase in the number of pollutants in the air, there is an increase in the demand for
air purifiers. These air purifiers can be used in offices, homes, commercial places, and if
their efficiency is high, then they can also be used outdoors. Air purifier is a device used
to remove contaminants like dust particles, cloth fibers etc. present in the air. These
devices are claimed to be beneficial to people having allergies, and asthma. The
commercially graded air purifiers are manufactured as either small stand-alone units or
larger units that can be affixed to an air handler unit (AHU) or to a heating ventilation and
air-conditioning (HVAC) unit found in the medical, industrial, and commercial industries.
Air purifiers may also be used in industry to remove impurities such as CO2 from air
before processing. A standard air purifier consists of various types of filters, and filter

levels to remove the contaminants from the surrounding air.

Dhaka faces pollution problems from all sides, as being a highly populated city, it would
be subject to the air contaminating effects of the massive use of cars, motorbikes and
trucks, many of which are not subject to strict regulations in regards to the age or quality
of their engines, or the fuels they run on. There is also the industrial side of the city,
contributing to the ever-growing pollution levels. Factory or production sites such as
brick kilns are responsible for the massively elevated levels of pollution. Due to an
economic boom and the subsequent increase in demand, Dhaka’s kilns are known to
produce billions of bricks each year, often relying on unregulated fuel sources for power
(such as the burning of coal, wood and any other combustible material) which can release

excessive amounts of noxious fumes and smoke into the atmosphere.

Besides these two issues, there are problems related to large dust concentrations building
up in the city, somewhat similar to the highly polluted city of Delhi in India, as well as
open burning sites where refuse containing organic matter as well as toxic materials such

as plastics and rubber are set alight in the streets.
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Figure 1.1: Historic Air Quality Graph for Dhaka

In order to reduce such elevated levels of pollution, many steps would need to be taken,
albeit in the face of such economic growth it would a task that the city of Dhaka would be
hard pressed to do. The introduction of stricter regulations regarding fuels and vehicles
allowed on the road would be helpful in the fight against reducing ambient pollution
levels in the air, with the removal of diesel fuel as well as ancient fume producing engines
being of large help. Other steps would be to introduce stricter measures to both factories
and construction sites, holding individual organizations accountable for the amount of
pollution that they produce, with the possibility of adding fines to those that exceed
unsafe levels of pollution, as well as particulate matter. Whilst certainly a compounded
issue, the introduction of these initiatives would be a step in the right direction for Dhaka
to obtain a cleaner level of air quality, and improve its US AQI readings as well as PM2.5

levels.

1.2 Background Study

In the present scenario pollution become very serious because of urbanization all around
the world. So, we need to concern about it because everyday activities are associated to
the environment. Make sure the condition is under control government established
monitoring facilities to know the current condition. Air pollution is most important

problem of the environment, which mainly concentrates in cities. So, we see many cities



has developed with the progressively industrialization and urbanization. air quality
standards with a diameter smaller than 10 u m. These fine particles are main concern for
us because this are capable of easily transported over long distance by the flow of air.
And these particles cause respiratory health problems and the recent studies shows that
AQI particles can penetrate to deepest part of the lung so this is the major concern for us
that’s why make a activated carbon air filter which is used to remove this harmful
particles from the atmosphere for better health and atmosphere so the main objective of
this project to provide affordable activated carbon filter to the house uses and many more.

1.3 Air Purifier

An air purifier is a device which removes contaminants from the air in a room. These
devices are extremely beneficial for allergy sufferers, asthmatics and at reducing or
eliminating second-hand tobacco smoke. They are also extremely useful for reducing
pollutants from a room if you live in a highly polluted environment, for instance New
Delhi, Patna or Gwalior; which are among the most air polluted cities in the world. They

also help eliminate virus and bacteria from a room which prevents the spread of disease.

1.4 USES AND BENEFITS OF AN AIR PURIFIER

Dust, pollen, pet dander, mould spores, and dust mite faces can act as allergens, triggering
allergies in sensitive people. Smoke particles and volatile organic compounds (VOCs) can
pose a risk to health. With the advancement in air purification technology, air purifiers are
becoming increasingly capable of capturing a greater number of bacterial, virus, and DNA
damaging particulates. Air purifiers are used to reduce the concentration of these airborne
contaminants and can be useful and fruitful for people who suffer from allergies and

asthma.



1.5 Objectives

The objectives of this project are:

a) To study of an Air Purifier System

b) To do technical advancement in the air purification field. It helps to clean air in
pollutant areas and provides quality of air.

c) To design an Air Purifier which operates with 6 advanced stages of filtration
using: a cold catalyst filter, a cellular-activated carbon filter, an anti-microbial
filter, a HEPA filter, an ionizer.

d) To overcome the use of traditional marking methods which is done with the
help of sprinkling of water to purify air can be reduced.

e) To test the performance of the Air Purifier System.

1.6 Organization of the Book

e Chapter 1: Introduction. This chapter is all about background study, air purifier,

use or air purifier, Objectives and thesis book organization.

e Chapter 2: Literature Review- Here briefly describe about air purifier
technology, filter availability, previous book review, Block diagram, Structural

Diagram, Components List and Summary of this chapter.

e Chapter 3: Hardware Analysis- This chapter is discussed about our project

hardware. Here we describe our hole instrument details.

e Chapter4: Methodology— Here briefly discuss about project methodology,
hardware parts, our system working mechanism, project final image, working

principle and our system overview.

e Chapter 5: Results and Discussion— Here briefly discuss about project
discussion, result analysis, advantages, disadvantages, application and our system

overview.

e Chapter 6: Conclusion — This chapter is all about our thesis future

recommendation and this project conclusion.
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CHAPTER 2
LITERATURE REVIEW

2.1 Introduction
This chapter mainly reviews literature, reviews of various types of work and highlights

the importance of IOT fishing management in such situations.

2.2 AIR PURIFIER TECHNOLOGY

The best performing air purifiers feature more than one filter technology, and using
HEPA style filtration is the key to optimal results. Filtration performance is not ideal
without the use of HEPA air purifiers, and symptoms of particle pollution, like allergies

and asthma, are not reduced.

2.3 FILTERS AVAILABLE TO PURIFY AIR

Air filters are device that take away particles, like dirt and VOC (volatile organic
compounds) these filters give you good air quality. So, if we see that there are many types
of filter available on the market but all have some unique property to ensure you to
provide good air for example ionic, carbon, UV air filter and HEPA they are usually

employed at the economic, commercial sectors

® |ONICAIRFILTER

lonic air filter we also say that air ionizer. They are different from the filter because of
their work as a negative ion generator. They release a negative ion charge which attached
to the pollutants and this bond particle falls down due to weight. By this filter, particles
may not be in air, but these particles still present in the room until you vacuum out this

particle.

® HEPAAIRFILTER

The term HEPA stands for high efficiency particulate air and what that basically means is
its special type of filter that captures microscopic particle these particles include things



the dust, pollen, bacteria etc. and particulate matter that corners from outdoor air
pollution. Heap air cleaners are devices that clean the air by removing microscopic
contaminants. this lead to cleaner, fresher air to breathe. HEPA filters catch particle
which are size of 0.3 microns or large and it almost take away up to 99.97 % of small

particles.

® CARBON AIR FILTER

It’s been specially treated with oxygen to open up the pores of the carbon atoms. What
this process does is increase the total surface area of the charcoal so it can capture certain
particles from the air. those particles include odour and gas molecule. as odours and gases
pass through a carbon filter the molecules react with the charcoal and stick to the surface.
essentially this removes bad smells and chemical gases from indoor air from things the
pain, volatile organic compound and more. Particles which captures by the carbon are
carbon monoxide, nitrogen oxides, sulphur dioxide, lead and particulate matter.

® UVAIRFILTER

UV light is designed for one purpose to Kill airborne bacteria and viruses. As air passes
through the air purifier, he UV light shines on the microorganisms and pathogens, and
this destroys their DNA structure. after the air is sterilized, those germs are harmless to

your health. Wavelength of these rays are 264nm

2.4 Literature Review

HEPA filters were originally classified as top-secret, developed by the US Atomic Energy

Commission to protect soldiers from radioactive particles on the battlefield. During World

War Il, scientists involved in the Manhattan Project used HEPA masks to guard against

contaminants from the atomic bomb. Although these early HEPA masks couldn’t possibly

protect people from atomic radiation, the research spawned the HEPA filter, which provided

protection against chlorine gas, mustard gas, and flame throwers. It was not until the 1960s

that specifications were standardized and the term HEPA or "High Efficiency Particulate

Air" was officially coined by the Department of Energy (DOE).



As defined by the DOE, HEPA filters remove at least 99.97% of dust, pollen, mold, bacteria
and any airborne particles with a size of 0.3 microns at 85 liters per minute. From the
beginning, HEPA filters were employed to filter out highly hazardous aerosols, toxic
carcinogens, radioactive particles, and biohazardous contaminates.

In Germany, brothers Klaus and Manfred Hammes purchased a patent for a simple air
filtration system. Using a fiberglass pad attached with small magnets to the air outlet of a
residential oil oven, the Hammes brothers were able to filter soot from the air. In 1963, the
Hammes brothers simple but effective filter became the first air cleaner to be utilized in
homes across Germany. In the same year, US Congress passed the Clean Air Act of 1963 to
set standards for the reduction of air pollution through fuel emissions standards. Although it
was not Congress first attempt at reducing air pollution, the Clean Air Act of 1963 alerted
scientists and consumers of the need to protect our lungs from pollutants such as perfumes,
building materials, chemicals, pesticides, and allergens. No longer classified as top-secret,
HEPA air filters became popular in the 1970s and 1980s as more consumers became
concerned about air pollution. With the introduction of dozens of products featuring HEPA
filters, new and exciting ways to control allergies and asthma finally became widely
available for residential use. Originally, the first HEPA air purifiers were bulky, difficult to
operate, and traditionally used only in hospital and pharmaceutical settings and among
computer chip manufacturers. Then businesses began to take notice of indoor air quality

concerns among residential consumers.

In response to the growing demand for cleaner air, Incen AG, the Hammes brothers newly
formed company moved to Switzerland and began developing and manufacturing residential
air purifiers in 1971. After many years of international success for Incen AG, Frank
Hammes, son of Klaus Hammes, began to distribute cabin air filters as add-on accessories

for Mercedes-Benz automobiles in 1990.

In 1991, Frank Hammes formed IQAir North America, which has promoted the continual
growth and success of the air purification industry. In 1991, through the amazing technology
of True Medical HEPA and Activated Carbon, Richard Taylor created a filter that addressed
the issues of environmental particulate contamination, chemical toxicity, and odours. It was
then that he and his wife Joyce founded Austin Air Systems Limited. Based out of Buffalo,
NY, Austin Air introduced a pre-filter that ensured a HEPA filter life unequaled to anything



in the industry. Austin Airs 360-degree intake system draws air into all sides of the air
cleaner, maximizing efficiency and delivering more clean air faster. With the largest air
cleaner manufacturing facility in the world, Austin Air continues to produce all the parts for
their fantastic air purifiers.

Established in 1992, Aller Air quickly became a trusted name in air purification. After a
family member of AllerAir founder Sam Teitelbaum developed Multiple Chemical
Sensitivity (MCS), Teitelbaum and partner Wayne Martin decided to develop their own air
cleaner. Using the combination of true HEPA filters and a MAC-B (mass activated carbon
bed) filters, which contain pounds of carbon, AllerAir created an air purifier that safely and
effectively removes chemicals, gases, and odours from the air. With offices in the United
States, Italy, and Canada, AllerAir air purifiers are used by the Mayo Clinic, IBM, Gucci,
Prada, and the U.S. Army. With more than 100 model to choose from, AllerAir air cleaners
are efficient, practical, and cost effective. With headquarters in Stockholm, Sweden, and
Chicago, the Blueair air purifier company is committed to creating a healthier environment
both indoors and out. Founded in Sweden in 1996, Blueair quickly earned a reputation for
high performance, technological innovation, and quality design. A revolutionary
combination of mechanical and electrostatic filtration allows Blueair purifiers to capture
99.97% of irritating particles, gases, and odours. With more than five different models, these
powerful yet near-silent air cleaners provide a visually-pleasing form and highly effective

function.

Now a global leader in the production of specialty products and chemicals and a subsidiary
brand of Kaz, Honeywell started as a hot water heater company in 1906 and has a
longstanding tradition of supplying safe, reliable, and high-quality products. Acquired by
Kaz in July of 2002, Honeywells indoor air quality products continually meet and exceed
the American Lung Associations Health House guidelines with meaningful innovations
based on consumer research and insights. With the use of permanent, lifetime HEPA filters,
Honeywell air cleaners remove 99.97% of all common, household particles such as dust,
pollen, tobacco, smoke, and cat dander. The Honeywell glass-fiber HEPA material helps
remove airborne particles without the use of expensive ultraviolet bulbs, chemicals, or other
treatments. With a diversity of products to fit your needs, Honeywell offers a series of

Home Comfort and Indoor Air Quality Solutions.



In 2002, IQAIr air purifiers became the first air cleaners to incorporate H13 class certified
HEPA filters, which capture up to 100 times more particles than conventional HEPA filters.
H13 class certified HEPA filters, up to that point, had only been used in hospital clean
rooms. * Although no longer a top-secret government project, air purifiers still hold the
secrets to cleaner air and healthier environments for many asthma and allergy sufferers.
Today HEPA air purifiers and filters are used in a variety of critical filtration applications in
nuclear, electronic, aerospace, pharmaceutical and medical fields, as well as in homes

around the world.

Research scholars at home and abroad have done a lot of research. Nowadays, indoor air
purification technology is mainly divided into two types: capture type and reactive type. The
capture type separates the contaminants from the air fluid by filtration or adsorption, leaving
the contaminants in the air purifier. The reaction type principle mainly removes gaseous
pollutants (molecular type pollutants) in the air by chemical reaction or ionization. Common
reaction mechanisms are UV sterilization, photo catalysis and chemical catalysis, room
temperature thermal catalysis, plasma and ozone oxidation. However, this purification
method is easy to cause secondary pollution. There are three common capture air cleaning
systems: mechanical filtration, electrostatic precipitator (ESP), and hybrid air purifiers
(Chan et al., 2015).

In 1963, the German Hammer brothers developed the first indoor mechanical filter to
remove soot from indoor air. The main components of mechanical filtration (also known as
fiber filtration) are fans and filter dust collectors (Klepeis et al., 2017). The built-in fan
draws indoor air into the purifier. The particulate pollutants in the air are filtered by
diffusion, interception, impact or inertial force. Its filtration efficiency is affected by the
structure of the air purifier, the nature of the filter material and the power of the fan. This
type of purifier uses a wide variety of filter materials, and the filtration function depends
mainly on the nature of the material. Porous filter materials such as nonwovens, filter paper
and fibrous materials are most commonly used. The air filter for filtering PM2.5 is usually
made of high-efficiency air filter material (HEPA: High Efficiency Particulate Air), and the
material is ultra-fine glass fiber or synthetic fiber, which is often processed into paper. As
early as the 1940s, the United States developed the earliest HEPA filter in the Manhattan

project, which was used to prevent the spread of radioactive pollutants in the air.



Nowadays, it has been widely used in the nuclear industry, pharmaceutical industry, food
industry and semiconductor industry (Oh et al., 2014). The main components of HEPA are
mostly glass fiber or quartz fiber. The efficiency of good HEPA material to remove
particulate pollutants in the air can be as high as 99.97%. The most important feature of this
material is the high efficiency of particle collection, but the resistance is very large. These
two parameters depend on the fiber structure (bulk density, fiber diameter and thickness),
operating conditions (filtration rate and temperature), and the characteristics of the trapped
aerosol (density, particle size, and particle size distribution). The particulate contaminants
are first deposited in the filter bed and deposited on the surface of the filter (Park et al.,
2017).

This process does not affect the apparent filtration rate. After that, a filter cake is formed on
the surface of the filter. As the particulate matter continues to deposit, the resistance
increases exponentially. Therefore, the requirements and energy consumption of the wind
turbines are getting higher. In order to reduce energy consumption, such air purifiers have to
periodically replace the filter media material. Moreover, the filter material is a one-time
consumable, which is not economical. In addition, long-term use of this filter can cause
contaminants to escape from the filter, producing human-perceivable contaminants.

Therefore, the mechanical filter air purifier has a lower market share (Rice et al., 2018).

However, primary filtration and intermediate filtration are still widely used in the pre-stage
protection of high efficiency filters. The electrostatic precipitator can use either high-voltage
positive electrode discharge or high-voltage negative electrode discharge, but they all use
corona discharge. It is mainly composed of a discharge electrode and a collecting electrode,
and the discharge electrode is connected to the first stage of the DC high voltage power
supply. Two prerequisites for corona discharge are high voltage power supplies and
electrodes with very small radii. The mechanism of action is to generate static electricity by
the corona discharge principle while generating an electrostatic field. Very small particulate
contaminants are ionized into positive ions and electrons as they flow through the high
voltage electric field. These particles can collide with other particles or air molecules to
charge the latter, and the electrons and positive ions move to the positive and negative
electrodes, respectively, to form an electric field across the gas between the two plates.
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Then, under the action of the electric field force, the charged particles are orientated in the
electric field along the direction of the power line to be captured on the collecting electrode,
and this process generates a minute current. The electrostatic air purifier does not need to
replace the filter material regularly like a mechanical air purifier. After the power is turned

off, the filter can be removed and cleaned for recycling (Shao et al., 2017).

Compared with the mechanical filter, the electrostatic precipitator air purifier is economical
and environmentally friendly. Therefore, it is attracting more and more people's attention,
becoming the mainstream trend of indoor dust collector research, and at the same time, it is
increasingly occupying the dominant market. With the development of this technology, the
electrostatic precipitator purifier has higher and higher dust removal efficiency and lower
energy consumption. However, during operation, the electrostatic precipitator air purifier
generates secondary pollutants, that is, ozone, due to high-voltage electricity ionizing
oxygen in the air. Moreover, the ozone concentration generated easily exceeds the indoor
average of 0.16 mg/m3 for one hour as stipulated by the National Indoor Air Quality
Standard (GB/T18883-2015), which is also the biggest drawback of this type of air purifier.
The filtration efficiency of such an air purifier is affected by a number of factors. The flow
of air can affect the electrostatic field, which in turn affects the charging and motion of

particulate contaminants.

At the same time, if the concentration of particulate matter is high, it will also affect the
electrostatic field, air flow field and particle motion. Common electrostatic air purifiers are
mainly divided into the following types: the conventional electrostatic air purifier consists of
an electrode and a trap plate. The electrodes are placed in a central position. The electric
field lines are perpendicular to the direction of air flow. The two-electrode plate electrostatic
air purifier can change the voltage. It removes particulate and gaseous contaminants such as
NOXx. The hybrid air purifier combines the principle of static electricity with other filtration
mechanisms to improve its filtration efficiency and economy. After passing through the
electrostatic field, a portion of the particles are captured by the collecting electrode and a
portion is captured by the fibrous material. These fiber materials do not require the use of
HEPA (HEPA resistance is too high, energy consumption is high) because charged particles
charge the fiber filter material, which increases the filtration performance of the fiber
material (Wongaree et al., 2016).
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The electrostatic precipitator system is designed with a water mist curtain at the front end of
the electrostatic precipitator system. On the one hand, it can cool down and lower the high
temperature gas to room temperature. On the other hand, the increase of humidity will cause
the condensation of some small particles (especially nanoparticles), thereby increasing the
particle size of the particle contaminants and improving the filtration efficiency. The
experimental results show that the filtration efficiency of the nano-particles with water mist
curtain and water mist curtain is 67.9%~92.9% and 99.2%~99.7%, respectively. The wet
electrostatic precipitator system has high filtration efficiency. However, the humidity of the
gas is greatly increased, causing discomfort to the human body. Therefore, it is not suitable
for use in indoor environments. The first stage of the dual zone electrostatic precipitator
system is the particulate pollutant charging area. There is a high voltage electric field in this
area, and the particles are charged under the action of a high voltage electric field.

The second stage is the settling area. The particles settle to the collecting plate under the
action of an electric field. Such a dust removing device is often used in the field of indoor
air purification because of its small size. Today, most of the air-based electrostatic
precipitators are used in the market. The main structures include electrostatic precipitators,
pre-filters, fiber composite layers, fans and negative ion generators. Physical and chemical
adsorption is the main mechanism of action of adsorption air purifiers. The adsorption
carriers commonly used in the two are activated carbon, silica gel, molecular sieves or
fibers. Physical adsorption often requires that the adsorbent support be porous and have a
large specific surface area. The principle is to use the intermolecular force to adsorb the
pollutants on the adsorption carrier to achieve the effect of removing pollutants. Today,
mainstream air purifiers on the market often use adsorption methods to remove harmful
gases or volatile organic compounds, such as sulfur dioxide, hydrogen sulfide, nitrogen

oxides, benzene, formaldehyde and toluene in the air (Xiao et al., 2018).

The advantage is that no matter the concentration of the pollutants, the adsorption effect can
be good, and the adsorption speed is fast. The chemical adsorption relies on the above-
mentioned materials as a carrier, coating a layer of active chemical substance on the surface
thereof as needed, or merging with these chemicals to form a novel purification medium.
Then, the pollutants in the air are removed by a chemical reaction method. Through

catalysis, decomposition, oxidation and neutralization, a variety of harmful substances in the
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air are adsorbed, thereby achieving the purpose of eliminating pollutants. However, once the

adsorption carrier is saturated, it needs to be replaced and cannot be recycled.

2.5 Block Diagram

In our project we have set up an Air Purifier System. In this circuit we have used one
exhaust fan for suck the air in inside of cylinder. Here we also use a air tower, air HEPA
filter, MQ 135 air quality monitoring sensor etc.. In this diagram we will show by block

the individual parts.

O

Air Pure Air
Airln = —>»| Hepa —>] MQ 135
Filter Out

v LCD Display

Figure 2.1: Block Diagram of Air Purifier System.

2.6 Structural Design

LLLLLLLL
;;;;;;;;;;;;;
LLLLLL

Figure 2.2: Schematic Diagram of Air Purifier System.
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2.7 Schematic Diagram

The schematic diagram here is representing the electrical circuit and the components of

the Air Purifier System. Here we connect equipment with he smart wire connection.
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Figure 2.3: Schematic Diagram of our circuit

2.8 Components List:

Hardware Part:
1. Metal Base
Steel Air Cylinder Tower
Exhaust Fan
HEPA Filter
MQ 135 Air Quality Monitoring System

Arduino Nano

N o a ~ wDn

Battery
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Software Part:
1. Arduino Software

2. Proteus Software

2.9 Summary

The above discussion gives an idea about the Air Purifier System. All that work on this
system already been done here, and the results of their work, the use of Air Purifier
System in the situation are described in detail. From this we also got the direction of

work of the project.
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CHAPTER 3
HARDWARE AND SOFTWARE ANALYSIS

3.1 HEPA TECHNOLOGY

HEPA is an acronym for High Efficiency Particulate Air and is a technology that has been
used for many years to filter particles. HEPA filters must meet a standard of trapping at
least 99.97% of all particles larger than 0.3 microns. The human eye can only see particles
larger than 10 microns; so particles caught in a HEPA filter such as chemicals, bacteria
and viruses cannot be seen. Because HEPA filters are able to trap mold and bacteria, they
create a more sanitary environment. Additionally, this does not generate ozone or any

other harmful byproducts.

Figure 3.1: HEPA Filter Working
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HEPA Filter

The HEPA filter is a very fine fiber-like material that has been folded back and forth to
create the shape of an accordion. This accordion shape creates a maze of randomly
arranged fibers and presents a very large surface for air to be pushed through by the air
purifier fan. Airflow must have an opportunity to pass through the filter in order for it to
be cleaned. The more times airflow passes through the filter in an hour, the cleaner the air
will become. Components of a HEPA Filter HEPA filters are made of boron silicate

microfibers formed into a flat sheet by a process similar to making paper.

Figure 3.2 HEPA Filter

Flat filter sheets are pleated to increase the overall surface area. Pleats are separated by
baffles which direct the airflow through the filter. Filter media is very delicate and should

never be touched.
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How a HEPA Filter Operates

Large particles will not be able to pass through the openings of the fibers and will

immediately get caught. The smaller particles will get caught by one of four mechanisms.

@ P

DIRECT SIEVING INTERCEPTION DIFFUSION
IMPACTION

<o

Figure 3.3: Filter absorb the small particle

Direct Impaction: Large contaminants, such as certain types of dust, mold, and pollen,

travel in a straight path, collide with a fiber, and stick to it.

Sieving: The air stream carries a particle between two fibers, but the particle is larger than

the gap, so it becomes ensnared.

Interception: Airflow is nimble enough to reroute around fibers, but, thanks to inertia,

particles continue on their path and stick to the sides of fibers.

Diffusion: Small, ultrafine particles move more erratically than larger ones, so they’re

more likely to hit and stick to fibers.

HEPA air purifiers are the most effective at trapping airborne particles; however, they do
not remove odours, chemicals or gases. Therefore, most HEPA air purifiers have some
level of activated carbon based material to absorb odours and chemicals not caught by the
HEPA filter.
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Types of HEPA Filter

An ideal HEPA filter for the best air purifier is the one that captures 99.97% of minute
dust particles as minute as 0.3 microns. Only a real HEPA Filter can achieve the above-
mentioned objective. Thus, this way you can adjudicate whether your filter is a true
HEPA Filter or not. HEPA Filter is classified with A to E stickers depending on their
efficiency. Type A is considered to be the least efficient and Type E the most efficient
appropriate for defenseless applications. Vacuum Cleaners generally have Type A filters

which work efficiently within our house.

HEPA Filter Strengths

® Remove dust, dust mites, pet dander, pollens, mold, some bacteria and other
common indoor allergens.

® Air contaminants that have been trapped in the filter won’t be released back into
the air.

® Does not generate ozone or harmful byproducts.

HEPA Filter Weaknesses

® Won’t remove odours, gases, chemical fumes, volatile organic compounds,
cigarette smoke, and ultra-small particles, viruses and germs (0.01 microns and
below).

® HEPA filter works passively. It requires a fan to draw in air in order to trap air
contaminants.

® Bacteria and viruses trapped in the filter can breed and reproduce.

TECHNOLOGY COMPLIMENT HEPA FILTER

The best technology to pair with HEPA style filtration in air purifiers really depends on
your concern. There are many different technologies that are used in air purifiers with
HEPA style filtration, such as activated carbon, pre-filters, ultraviolet light, and ionizers.
Choosing thebest air purifier with the most efficient technology can be easy with some

research and comparison. While searching through many air purifiers to find your perfect
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solution, be aware that the technology used is the most important factor you should

consider. [
® Pre-Filters

A pre-filter captures the largest particles before they reach the more expensive HEPA
filter. Most of the particles in your air are large particles like dander and dust, not tiny
ones like pollens and microbes. Even though HEPA filters have a large number of pleats
to maximize their surface area, they can fill up quickly if larger particles are not pre-
filtered out. [J

® Activated Carbon

Elements like activated carbon, zeolite, or potassium permanganate are added to air
purifier filters to increase efficiency to the filtering system. These elements work to
absorb smoke, gases, chemicals, and odours that are present in the air. Activated carbon
neutralizes odours and traps harmful chemicals and gases in its pores to provide relief
from activities like secondhand smoke, off-gassing from plastics, and harmful fumes
produced from renovations. An effective filtering system that is also equipped with

chemical adsorption materials can produce cleaner and fresher-smelling air. [
® Ultraviolet Light

Ultraviolet light (UV) technology is key to neutralizing viruses and bacteria that
accumulate on air purifier air filters. It is important to use the UV technology in
combination with HEPA air filters and possibly activated carbon. Without a particulate
filter system like a HEPA air filter, too many microorganisms may be hidden from the

UV light, since it is not easily located on an air filter.

Table 01 Alternative Filters

Alternative Technology Pros Cons

Pre-Filters Captures large particles * May be | Requires maintenance
washable ¢ Extends life of HEPA
filter
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Activated Carbon Absorbs odours, gases, and | Heavy * Expensive
chemicals + Leaves space
smellingfresh « Removes tobacco

smoke and pet odours

Ultraviolet Light *Neutralizes microorganisms,

like bacteria and viruses

3.2 AC Exhaust Fan

Exhaust fans are used to pull excess moisture and unwanted odors out of a particular
room or area. They are commonly found in bathrooms and kitchens, where moisture can
build up due to activities such as showering, washing, or cooking. The existence of clean
air in the house is something that every homeowner must pay attention to. As is known,
dirty air trapped in the house can cause various diseases, especially respiratory diseases
for all family members. Because of that, every house must have a good air circulation
system by installing ventilation. As for people who live in urban areas, often the presence

of ventilation is not enough to replace the air in the house.

Figure 3.4: AC Exhaust Fan
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Exhaust fans are a solution so that the exchange of clean air and dirty air in the house can
run well. Sometimes homeowners can install more than 1 exhaust fan in the house.
Usually the rooms where the exhaust fan is installed are the bathroom and kitchen or
places with poor air circulation. There are various types of exhaust fans available in the
market. Just adjust it to the needs and benefits you want to get. Even so, it turns out that

the exhaust fan has its own advantages and disadvantages.

Exhaust Fan Advantages

The existence of an exhaust fan provides many advantages, especially if it is installed in a

room with poor air circulation. The advantages of exhaust fans include:

1. Improve Indoor Air Quality

Exhaust fans installed in rooms such as bathrooms or kitchens can help improve air
quality to be cleaner. Stuffy air like in the bathroom to the smell of cooking that is too

strong can be replaced immediately if there is an exhaust fan in the room.

2. Eliminate Bad Smell

The unpleasant and pungent smell is very disturbing. Especially if the aroma comes from
a room with a poor air exchange system such as in the bathroom. This makes people think
that the room is very dirty and makes people reluctant to enter it. For this reason, the
installation of an exhaust fan is necessary to reduce or eliminate unpleasant odors in the
room. That way the air in the room remains clean and does not smell when entering the

room.

3. Removes Air Moisture

A humid room makes the air stuffy and smelly. If left unchecked, it is not impossible to
damage the walls and ceiling of the house because it is too wet. Even in certain parts can
be overgrown with moss and fungus which of course can damage a room. For this reason,
the installation of an exhaust fan is very useful to quickly remove moisture from the air.

That way the air in the room remains dry and not too humid because of good air exchange
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by the exhaust fan. Installing an exhaust fan in the bathroom can also help eliminate

foggy mirror syndrome due to too high humidity.

4. Reduce Air Contamination

Cooking smoke, cigarette smoke, hot air, and unpleasant odors are very disturbing to the
human respiratory system. Especially if the air is dangerous and causes a disease if
inhaled for a long time. For this reason, the existence of clean air must always be
available in the house in order to provide comfort for every family member. Removing
contaminated and dirty air does not need to open all windows and doors of the house, just
use an exhaust fan. Because the change of air becomes faster and easier if you use an

exhaust fan.

5. Can Be Used as an Air Conditioner

Exhaust fans can also cool the air in the room. This is in accordance with the working
principle of the exhaust fan, which is to absorb hot air in the room to the outside, then

replace it with new air so that the room becomes cooler.

At first glance, the way it works is similar to a fan, but it is more efficient at dissipating

heat in the room.

Disadvantages of Exhaust Fan

Behind the advantages, it turns out that the exhaust fan also has several disadvantages,

including:

e Almost all exhaust fans sold on the market use electricity in the form of
electricity, so that in the event of a power outage, of course the exhaust fan

cannot work.

e Some types of exhaust fans must be installed in the wall or even become one
with the ceiling of the house or ceiling. In other words, the exhaust fan cannot

be moved anywhere.
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« If the installation is not done properly, there is a possibility that hot and humid
air can escape to other areas in the house. Not only that, an exhaust fan that is
not properly insulated, when air is drawn from the interior, can be lost in the

attic of the house and can actually cause another problem such as damp tiles.

o Improper installation of the exhaust fan can make a noise when the fan rotates.
The sound produced is very disturbing to the occupants of the house, so it is

very likely that the exhaust fan will not be operated.

e Exhaust fans are only used to remove air from inside to outside the room or in

one direction.

Application

Exhaust fans cool down the indoor spaces, ventilate the hot and stuffy air, and can prevent

the excess amount of moisture content effectively from building u in the damp areas.

3.3 Arduino Nano

Arduino is an open source electronics prototyping platform based on flexible, easy-to-use
hardware and software. It's intended for artists, designers, hobbyists, and anyone
interested in creating interactive objects or environments. Arduino can sense the
environment by receiving input from a variety of sensors and can affect its surroundings

by controlling Lights, motors, and other actuators.

Figure 3.5: Arduino Nano
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The microcontroller on the board is programmed using the Arduino programming
language (based on Wiring) and the Arduino development environment (based on
Processing). Arduino projects can be stand-alone or they can communicate with software

on running on a computer (e.g. Flash, Processing, Maxims”).

Vcc
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Switch(Normally Open)

.||_D_/ RESET AS

-
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D8 D9 (PWM)

I ATmega328

Figure 3.6: Arduino Nano Schematic Diagram

D7 D10 (PWM)

Arduino Nano is a surface mount breadboard embedded version with integrated USB. It is
a small, complete, and breadboard friendly component. It has everything that Decimal/
Duemilanove has (electrically) with more analog input pins and onboard +5V AREF
jumper. Physically, it is missing power jack. The Nano can automatically sense and
switch to the higher potential source of power. Nano’s got the breadboard-ability of the
Boarding and the Minibus with smaller footprint than either, so users have more
breadboard space. It’s got a pin layout that works well with the Mini or the Basic Stamp
(TX, RX, ATN, and GND on one top, power and ground on the other).

GND RXD
lRSTlTXD
4
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(ATMEGA328P) ok P

SMD Cystal
(16MHz)
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Reference 51230 al“A2" A3 A4 AS A6 A7 5U RSTGND UIN
Digital Pin 13 € s AP0 eeemee @y
3.3V Output
s Analog Input Pins RESET Button
RST Vin (150gf)

Figure 3.7: How Arduino Nano looks like
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Specifications

Microcontroller: Atmel ATmega328

Operating Voltage (logic level): 5V

Input VVoltage (recommended): 7-12 V

Input Voltage (limits): 6-20 V

Digital 1/0 Pins: 14 (of which 6 provide PWM output)
Analog Input Pins: 8

DC Current per 1/0 Pin: 40 mA

Flash Memory: 32 KB (of which 2KB used by boot loader)
SRAM: 2 KB

EEPROM: 1 KB

Clock Speed: 16 MHz

Dimensions: 0.70” x 1.70”

Microcontroller IC ATmega328p

Figure 3.8: Microcontroller ICAT mega 328p

Features:

Automatic reset during program download
Power OK blue LED

Green (TX), red (RX) and orange (L) LED
Auto sensing/switching power input

Small mini —B USB for programming and serial monitor
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e |ICSP header for direct program download
e Standard 0.1 spacing DIP (breadboard friendly)

e Manual reset switch

The high-performance Microchip Pico Power 8-bit AVR RISC-based microcontroller
combines 32KB ISP flash memory with read-while-write capabilities, 1024B EEPROM,
2KB SRAM, 23 general purpose 1/O lines, 32 general purpose working registers, three
flexible timer/counters with compare modes, internal and external interrupts, serial
programmable USART, a byte-oriented 2-wire serial interface, SPI serial port, a 6-
channel 10-bit A/D converter (8-channels in TQFP and QFN/MLF packages),
programmable watchdog timer with internal oscillator, and five software selectable power
saving modes. The device operates between 1.8-5.5 volts. By executing powerful
instructions in a single clock cycle, the device achieves throughputs approaching 1 MIPS

per MHz, balancing power consumption and processing speed.

3.4 MQ 135 Air Quality Monitoring System

MQ-135 is a gas sensor that has lower conductivity in clean air. It is low cost and suitable
for different applications. This module operates at 5V, has 33Q+5% resistance, and
consumes around 150mA.This sensor has four pins from four pins, Digital and Analog
output pins, which are used to approximate these gasses levels in the atmosphere. When
these gasses go beyond a threshold limit in the air, the digital pin rises. This threshold

value can be set by using the onboard potentiometer.

Figure 3.9: MQ 135 Sensor
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Features of MQ-135 Sensor

. Wide detecting scope, Fast response, and High sensitivity
Long lifespan
Heater Voltage: 5.0V

It contains analog output and high/low digital output

. The operating Voltage is +5V
Detected/Measure NH3, NOX, alcohol, Benzene, smoke, CO2, etc.

1

2

3

4

5. The TTL output signal is a low level

6

7

8. Detection Range: 10 — 300 ppm NH3, 10 — 1000 ppm Benzene, 10 — 300 Alcohol

Working Mechanism

The MQ-135 Gas sensor consists of Tin Dioxide (SnO2). When target pollution gas
exists, the sensor’s conductivity increases along with the gas concentration. Users can
convert the change of conductivity to correspond to the output signal of gas concentration
through a simple circuit. The MQ-135 gas sensor has a high sensitivity to NH3, S2, C6H6
series steam and can monitor smoke and other toxic gasses. It can detect kinds of toxic

gasses.

Pinout of MQ135

The MQ-135 sensor module has four pins, with the most important part being an

adjustable potentiometer.

(i) £
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Figure 3.10: MQ 135 Pin Out
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The MQ-135 Gas sensor can detect gases like Ammonia (NH3), sulfur (S), Benzene
(C6H6), CO2, and other harmful gases and smoke. Similar to other MQ series gas sensor,

this sensor also has a digital and analog output pin.

Pin Number Pin name Details
1 VCC Pin The Pin requires 5V to power the module.
2 Ground Pin To connect the module to the system’s

common Ground

3 Digital Output Pin | This pin sets the threshold value by using a

potentiometer.

4 Analog Output Pin | The analog voltage pin is based on the
concentration of the gas

3.5 LCD Display
The 16 x 2 LCD pin shown below:

« Pinl (Low / Source PIN): This is a GND display pin, used to connect the GND
end of a microcontroller unit or power source.

* Pin2 (VCC / Source Pin): This is a display power supply pin, used to connect a
power supply pin.

« Pin3 (VO / VEE / Control Pin): This pin controls the difference of the display,
which is used to connect a flexible POT that can deliver 0 to 5V.

» Pin4 (Register Select / Control Pin): This pin turns between a command or data
register, which is used to connect a microcontroller unit pin and gets 0 or 1 (0 =
data mode, and 1 = command mode).

» Pin5 (Read / Write / Control Pin): This pin shifts the display between the read or
written function, and is connected to the microcontroller unit pinto get0or 1 (0 =
Write Task, and 1 = Read Task).

* Pin 6 (Enable / Manage Pin): This pin should be held at the top to perform the
reading / writing process, and is connected to the microcontroller unit and kept
high.
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« 7-14 Anchors (Data Anchors): These anchors are used to send data to the display.
These pins are connected to two wiring modes such as 4-wire mode and 8-wire
mode. In 4-wire mode, only four pins are connected to the microcontroller unit
such as 0 to 3, and in 8-wire mode, 8 pins are connected to the microcontroller
unitasOto 7.

« Pinl5 (+ ve LED pin): This pin is connected to + 5V

» Pin 16 (-ve LED pin): This pin is connected to GND.

D7
Backlight (+)
Backlight (-)

Figure 3.11: LCD Display

Features of LCD 16x2

The features of this LCD mainly include the following.

e The operating voltage of this LCD is 4.7V-5.3V
e Itincludes two rows where each row can produce 16-characters.
o The utilization of current is 1mA with no backlight

o Every character can be built with a 5x8-pixel box
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e The alphanumeric LCDs alphabets & numbers

o Isdisplay can work on two modes like 4-bit & 8-bit
e These are obtainable in Blue & Green Backlight

o Itdisplays a few custom generated characters

3.6 Battery

Lithium batteries are primary batteries that have metallic lithium as an anode. These types
of batteries are also referred to as lithium-metal batteries. They stand apart from other
batteries in their high charge density and high cost per unit. Depending on the design and
chemical compounds used, lithium cells can produce voltages from 1.5 V (comparable to
a zinc—carbon or alkaline battery) to about 3.7 V.

Disposable primary lithium batteries must be distinguished from secondary lithium-ion or
a lithium-polymer, which are rechargeable batteries. Lithium is especially useful, because
its ions can be arranged to move between the anode and the cathode, using
an intercalated lithium compound as the cathode material but without using lithium metal
as the anode material. Pure lithium will instantly react with water, or even moisture in the

air; the lithium in lithium ion batteries is in a less reactive compound.

Figure 3.12: 3.7V Battery

Lithium batteries are widely used in portable consumer electronic devices. The term
"lithium battery" refers to a family of different lithium-metal chemistries, comprising

many types of cathodes and electrolytes but all with metallic lithium as the anode. The
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battery requires from 0.15 to 0.3 kg of lithium per kWh. As designed these primary
systems use a charged cathode, that being an electro-active material with crystallographic

vacancies that are filled gradually during discharge.

Product Specification

Voltage 3.7V
Product Type Lithium-lon
Battery Capacity 2200mAh
Weight 459
Model Number ICR 18650

3.7 Arduino IDE

The digital micro-controller unit named as Arduino Nano can be programmed with the
Arduino software IDE. There is no any requirement for installing other software rather
than Arduino. Firstly, Select "Arduino Nano from the Tools, Board menu (according to
the micro-controller on our board). The IC used named as ATmega328 on the Arduino
Nano comes pre burned with a boot loader that allows us to upload new code to it without

the use of an external hardware programmer.

Communication is using the original STK500 protocol (reference, C header files). We
can also bypass the boot loader and programs the micro-controller through the ICSP (In
Circuit Serial Programming) header. The ATmegal6U2 (or 8U2 in the revl and rev2
boards) firmware source code is available. The ATmegal6U2/8U2 is loaded with a DFU
boot loader, which can be activated by:

On Rev1l boards: connecting the solder jumper on the back of the board (near the map of
Italy) and then resetting the 8U2. On Rev2 or later boards: there is a resistor that pulling
the 8U2/16U2 HWB line to ground, making it easier to put into DFU mode. The Arduino
Nano is one of the latest digital micro-controller units and has a number of facilities for
communicating with a computer, another Arduino, or other micro-controllers. The

ATmega328 provides UART TTL at (5V) with serial communication, which is available
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on digital pins 0 -(RX) for receive the data and pin no.1 (TX) for transmit the data. An
ATmegal6U2 on the board channels this serial communication over USB and appears as
a virtual com port to software on the computer. The '16U2 firmware uses the standard
USB COM drivers, and no external driver is needed. However, on Windows, an .in file is
required. The Arduino software includes a serial monitor which allows simple textual

data to be sent to and from the Arduino board.

The RX and TX LEDs on the board will flash when data is being transmitted via the
USB-to-serial chip and USB connection to the computer (but not for serial
Communication on pins 0 and 1). A Software Serial library allows for serial
communication on any of the Nano's digital pins. The ATmega328 also supports 12C
(TWI) and SPI communication. The Arduino software includes a Wire library to simplify
use of the 12C bus. Arduino programs are written in C or C++ and the program code
written for Arduino is called sketch. The Arduino IDE uses the GNU tool chain and AVR
Lab to compile programs, and for uploading the programs it uses argued. As the Arduino
platform uses Atmel microcontrollers, Atmel's development environment, AVR Studio or

the newer Atmel Studio, may also be used to develop software for the Arduino.

€D sketch_sep14a | Arduino 1.6.11 (Windows Store 1.6.11.0) - m] X
File Edit Sketch Tools Help

sketch_sep14a

roid setup() {

Figure 3.13: Arduino Software Interface IDE
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The Arduino Integrated Development Environment - or Arduino Software (IDE) -
contains a text editor for writing code, a message area, a text console, a toolbar with
buttons for common functions and a series of menus. It connects to the Arduino and

Genuino hardware to upload programs and communicate with them.

Writing Sketches

Programs written using Arduino Software (IDE) are called sketches. These sketches are
written in the text editor and are saved with the file extension. The editor has features for
cutting/pasting and for searching/replacing text. The message area gives feedback while
saving and exporting and also displays errors. The console displays text output by the
Arduino Software (IDE), including complete error messages and other information. The
bottom right hand corner of the window displays the configured board and serial port.
The toolbar buttons allow you to verify and upload programs, create, open, and save

sketches, and open the serial monitor.

Sketchbook

The Arduino Software (IDE) uses the concept of a sketchbook: a standard place to store
your programs (or sketches). The sketches in your sketchbook can be opened from the
File > Sketchbook menu or from the Open button on the toolbar. The first time you run
the Arduino software, it will automatically create a directory for your sketchbook. You
can view or change the location of the sketchbook location from with the Preferences
dialog. Beginning with version 1.0, files are saved with a file extension. Previous
versions use the .pde extension. You may still open .pde named files in version 1.0 and

later, the software will automatically rename the extension to .ino.

Tabs, Multiple Files, and Compilation

Allows you to manage sketches with more than one file (each of which appears in its own
tab). These can be normal Arduino code files (no visible extension), C files (.c
extension), C++ files (.cpp), or header files (.h).
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Uploading

Before uploading your sketch, you need to select the correct items from the Tools >
Board and Tools > Port menus. The boards are described below. On the Mac, the serial
port is probably something like /dev/tty.usbmodem241 (for an Uno or Mega2560 or
Leonardo) or /dev/tty.usbserial-1B1 (for a Duemilanove or earlier USB board), or
/dev/tty.USA19QW1b1P1.1 (for a serial board connected with a Keyspan USB-to-Serial
adapter). On Windows, it's probably COM1 or COM2 (for a serial board) or COM4,
COM5, COM?7, or higher (for a USB board) - to find out, you look for USB serial device
in the ports section of the Windows Device Manager. On Linux, it should be
/dev/ttyACMX , /dev/ttyUSBx or similar. Once you've selected the correct serial port and
board, press the upload button in the toolbar or select the Upload item from the Sketch
menu. Current Arduino boards will reset automatically and begin the upload. With older
boards (pre-Diecimila) that lack auto-reset, you'll need to press the reset button on the
board just before starting the upload. On most boards, you'll see the RX and TX LEDs
blink as the sketch is uploaded. The Arduino Software (IDE) will display a message

when the upload is complete, or show an error.

Libraries

Libraries provide extra functionality for use in sketches, e.g. working with hardware or
manipulating data. To use a library in a sketch, select it from the Sketch > Import Library
menu. This will insert one or more #include statements at the top of the sketch and
compile the library with your sketch. Because libraries are uploaded to the board with
your sketch, they increase the amount of space it takes up. If a sketch no longer needs a

library, simply delete its #include statements from the top of your code.

Third-Party Hardware

Support for third-party hardware can be added to the hardware directory of your
sketchbook directory. Platforms installed there may include board definitions (which
appear in the board menu), core libraries, bootloaders, and programmer definitions. To
install, create the hardware directory, then unzip the third-party platform into its own sub-
directory. (Don't use "arduino™ as the sub-directory name or you'll override the built-in

Arduino platform.) To uninstall, simply delete its directory.
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For details on creating packages for third-party hardware, see the Arduino IDE 1.5 3rd

party Hardware specification.
Serial Monitor

This displays serial sent from the Arduino or Genuino board over USB or serial
connector. To send data to the board, enter text and click on the "send™ button or press
enter. Choose the baud rate from the drop-down menu that matches the rate passed to
Serial. begin in your sketch. Note that on Windows, Mac or Linux the board will reset (it
will rerun your sketch) when you connect with the serial monitor. Please note that the
Serial Monitor does not process control characters; if your sketch needs a complete
management of the serial communication with control characters, you can use an external

terminal program and connect it to the COM port assigned to your Arduino board.

3.8 Proteus Software

The Proteus Design Suite is a proprietary software tool suite used primarily for electronic
design automation. The software is used mainly by electronics design engineers and
technicians to create schematics and electronics prints for manufacturing printed circuit

boards.

The first version of what is now the Proteus Design Suite was called PC-B and was
written by the company chairman, John Jameson, for DOS in 1988. Schematic Capture
support followed in 1990 with a port to the Windows environment shortly thereafter.
Mixed mode SPICE Simulation was first integrated into Proteus in 1996 and
microcontroller simulation then arrived in Proteus in 1998. Shape based auto routing was
added in 2002 and 2006 saw another major product update with 3D Board Visualization.
More recently, a dedicated IDE for simulation was added in 2011 and MCAD
import/export was included in 2015. Support for high speed design was added in 2017.
Feature led product releases are typically biannual, while maintenance based service

packs are released as required.
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Figure 3.14: Proteus Software Interface
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CHAPTER 4
METHODOLOGY

4.1 Our methodologies for the project:

e Creating an idea for the design and construction of Air Purifier System.
And designing a block diagram to know which components we need to

construct it.
e Collecting all the components for our desired system.

e Setting up all the components in a system. Then assembling all the blocks in
a system and finally running the system to check if it actually works or not.

4.2 Hardware Parts

Figure 4.1: Steel Base Sheet
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Figure 4.2: Air HEPA Filter

Figure 4.3: AC Exhaust Fan
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Figure 4.5: Exhaust Fan setup on Air Cylinder Structure
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4.3 Our System Working Mechanism

Exhaust Fan

HEPA Filter

Figure 4.6: Our Final System Working Mechanism

4.4 Our Project Final Image

Figure 4.7: Our Final System Overview (Air Cylinder Structure)
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Figure 4.8: Air Quality Monitoring Circuit

4.5 Working Principle

In this system we want to build an air purifier system. Which is mainly purify the dust air.
Here we use an air cylindrical chamber, exhaust fan, HEPA filter, MQ 135 air quality
monitoring system, metal base etc. The exhaust fan suck the air from surrounding air from
down to upper situation. When the dust air inside the cylinder then the HEPA Filter will
purify that air and pure air will blow in other side. In this side we will measure the air
purity through a sensor which is MQ 135 air quality monitoring sensor. Here we can get

the purify air from this system. This is the main procedure of our system.
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CHAPTER 5
RESULTS AND DISCUSSION

5.1 Discussion

While working on our project, we did face some difficulties as it is a very complex
system but the end results, we came up with were quite satisfactory. We have put the
whole system through several tasks to validate our work and also have taken necessary
notes for future improvements. Some future recommendations that we have involves

improvement in system design and wiring, adding features for more efficient.

We have tested the air purifier in different places of our university and different locations
of Dhaka city. We found different values in different places. In every places we found the
air quality unhealthy at the starting time. We have run the air purifier continuously 30
minutes in every place and note down the air quality after every 5 minutes. After running
for some time our air purifier starts turning the polluted air into clean air. At some places
the air quality was able to be brought to a healthy level and at some places the air quality
was able to be brought to a moderate level in 30 minutes. In the classroom of our
Sonargoan university the air quality was able to be brought to a healthy level within 25

minutes. By getting clean air, we can realize that our air purifier is working well.

After tested the air quality of different places of Dhaka our observation is Mirpur area
more polluted than other places. And the air quality of our classroom of Sonargoan

university is much better than other places.

5.2 Results

Now, it’s time to talk about the results.

e When this project is run then the exhaust fan will be rotate and suck the air into
the cylinder.

¢ Inside of the system the air will enter the down side of cylinder.

e Then the HEPA filter will purify the air and pass the upper side of cylinder.

e In upper side we measure the air purify with the MQ 135 air quality monitoring

Ssensor.
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5.3 Air Quality Detected at Different Places and Time

Time Mechanical | Mechanical Class | Dhanmondi- | Mirpur-2 | Nakhalpara
(in minutes) | Lab of SU Room of SU 32
0 114 105 115 201 131
05 95 89 101 170 121
10 82 78 90 155 107
15 71 68 81 136 91
20 60 59 78 109 80
25 51 49 71 98 76
30 47 43 63 81 61

5.4 Data Graph
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Figure 5.1: Air Quality Measuring After 5 Minutes

Figure 5.2: Air Quality Measuring After 30 Minutes
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CHAPTER 6
CONCLUSION

6.1 Conclusion

Air cleaners (with HEPA filters) placed in the room chamber effectively reduced the PM
concentration to a large extent whereas the concentrations of ions fluctuated. The
purifying efficacy of both air purifiers was enhanced in the presence of candles and
incense smoke and smaller particles were removed more efficiently as compared to larger
ones. Still, PM concentrations were much higher than standards prescribed by national
and international agencies that advocate the fact that source control is the best solution to
deal with the problem of IAP rather than air purification. On a comparison basis, air
purifier with greater CADR and coverage area was more effective on particulate pollution
in general indoor air as well as candles and incense smoke support the fact of adoption of
air purifier with higher coverage area (or CADR) for air filtration. Though it is a short-
term study, it doesn't fully adhere specificity of ions in presence of an air purifier. So,
long-term studies are needed to be conducted to clarify the specificity of ions release from
air purifiers. For the sake of health safety, air purifiers with mechanical filters (as HEPA)

must be used instead of that which releases ions for air purification.

6.2 Future Scope

There’s room for improvement and thus, we have lots of future scope of work available to

us for this project. Some of these are listed below:

e In future, we are thinking adding more feature on this system to more purify air.
e In future, we are thinking adding solar for power supply.

e In future, we are thinking about increase its working area.

¢ In future development this project can be develop by more measuring sensor.

¢ In the future we will add auto alarming system when need to change the filter.
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Appendix

Micro-Controller Program:

#include <LiquidCrystal_12C.h>

LiquidCrystal_12C lcd(0x27 ,16,2);

const int mg135_aqi_sensor = Al;

intagi_ppm =0;

void setup() {
/I Set direction of input-output pins

pinMode (mq135_aqgi_sensor, INPUT);

/I Initiate serial and lcd communication
Serial.begin (9600);

Icd.init();

Icd.backlight();

Icd.begin(16,2);

Icd.clear();

Serial.printIn("AQI Alert System");
Icd.setCursor(0, 0);
Icd.print("AQI Alert System™);

delay(1000);
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}
void loop() {

agi_ppm = analogRead(mq135_aqi_sensor);

Serial.print("Air Quality: ");

Serial.printin(agi_ppm);

Icd.setCursor(0, 0);
Icd.print("Air Quality: ");

Icd.print(agi_ppm);

if ((agi_ppm >= 0) && (agi_ppm <= 50))
{
Icd.setCursor(0, 1);
Icd.print("AQI Good");
Serial.printin("AQI Good");
¥
if ((agi_ppm >=51) && (aqi_ppm <= 100))
{
Icd.setCursor(0, 1);
Icd.print("AQI Moderate™);

Serial.printin("AQI Moderate™);

¥
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if ((agi_ppm >= 101) && (aqi_ppm <= 200))
{
Icd.setCursor(0, 1);
Icd.print("AQI Unhealthy");
Serial.printin("AQI Unhealthy");
}
if ((agi_ppm >=201) && (aqgi_ppm <= 300))
{
Icd.setCursor(0, 1);
lcd.print("AQI V. Unhealthy");
Serial.printin("AQI V. Unhealthy");
}
if (agi_ppm >=301)
{
Icd.setCursor(0, 1);
Icd.print("AQI Hazardous");
Serial.printIn("AQI Hazardous");

by

delay (1000);
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